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Introduction


Thanks for downloading and reading this Definitive Guide to the widely popular 4NEC2 Antenna Modeling software. 4NEC2 is a NEC based antenna modeler and optimizer developed by Arie Voors. This is a 3rd party book and is not connected to Arie Voors in any way. If you find mistakes in this book, they are all mine. :) 


The sample version of the book is complete but the full version is in progress. As chapters or appendices are completed, they will be released as updates. All updates for the sample and full version of this book are FREE, and it’s available in PDF, ePUB, and MOBI formats.


The full version of the book starts with chapter 4 that covers the different 4NEC2 editors. The Geometry Editor, due to it’s complexities, warrants its own chapter. Other chapters will include using the optimizer and matching tools, using gnuplot for high resolution graphs, using ItsHF and VOACAP, with the remaining chapters on design and analysis of various kinds of antennas such as verticals, multi-element, loops, satellite, and a grab bag of antennas the author finds interesting.


If you’d like to give feedback, please do via Leanpub 4NEC2 Definitive Guide feedback page. 


Conventions


Selecting Menus


Directions to which menu to use is shown as Edit->Copy where the menu is left of the -> and the menu option is to the right of the ->. Sub-menus  are shown as Run->Quickly->possible. Both menus and their options matches what is shown in the program.


Program Specific Text


Program specific text IE: menu text and screen output, etc will look like this Program Specific Text a fixed monospaced font.


Warnings, Tips, Errors, Information



    This is a warning!

  Warning, this is a warning!






    This is a tip!

  Tips look like this.






    This is an error.

  ERROR: Antennas work the first time they’re built!






    This is just info

  QST, QST - Bulletin about 4NEC2 Definitive Guide.





PC Requirements


Just about all computers of recent vintage can run 4NEC2 without issues. 
Obviously the more memory and CPU speed you have the faster the analysis 
will go and the more complex of an antenna that can be analyzed.


Supported Operating Systems


Basic functionality was tested on the following operating systems.



  	Windows 7 64bit

  	Windows 8 64bit

  	Windows 10 64bit










About the Author


Mark Schoonover has been licensed since 1982 when he got his Novice license on a wager with his dad. If he didn’t pass his Novice test, he had to mow the lawn for FREE all summer break. He got his General license in 1983 from the now long closed FCC Field Office in San Francisco. Upon his return from Navy active duty in 1987 he got his Advanced license. Around 2000 he got his Extra. He’s held his call since 1982 and doesn’t have any plans to obtain a vanity call. He enjoys long distance cycling, hiking, homebrewing and contesting from his pip-squeak station located in Arizona. 


Professionally, he has a degree in Computer Science and Software Engineering. He switched from Electrical Engineering when the internet became publicly available. Currently he’s an IT Solutions Architect for a major health care provider in the United States.








Chapter One - Installation


Downloading and installing 4NEC2 will be covered in this chapter. Installation is straight forward and the default settings will be used throughout this  book for all screen captures. The author is using Windows 10 64bit for this book. Screens in other operating systems may look slightly different but otherwise 4NEC2 will function identically.


Downloading 4NEC2


4NEC2 can be downloaded from http://www.qsl.net/4nec2/. This book will
cover version 5.9.2 released in March 2021 and will be updated as new versions of 4NEC2 mecome available. There are several 
different files available to download. For this book, you’ll need to download 4nec2(setup.exe) from the left menu. If you don’t see the download menu section, scroll down. Simply right-click on 4nec2(setup.exe) and save it to your desktop or downloads folder. 4NEC2 can be installed from any directory.


Installing 4NEC2 and Configuration


Extract 4NEC2 by right-clicking on the 4nec2.zip file and select Extract All from the flyout menu. Double-click on the 4nec2 folder that was created, then double-click again on the Setup4nec2.exe file. The following window will appear: 




  
    [image: 4NEC2 Opening Screen]
    4NEC2 Opening Screen
  




Click Next to continue and Next again to accept the default installation directory.




  
    [image: 4NEC2 Default Installation Directory]
    4NEC2 Default Installation Directory
  




The Start Menu window will be displayed:




  
    [image: Add to the Windows Start Menu]
    Add to the Windows Start Menu
  




Click Next to continue. The create desktop icon window will be displayed:




  
    [image: Create 4NEC2 Desktop Icon]
    Create 4NEC2 Desktop Icon
  




Click Next to continue. The Ready to Install window will be displayed:




  
    [image: 4NEC2 Ready to Install Confirmation]
    4NEC2 Ready to Install Confirmation
  




Click the Install button to start installation. Watch the little green bar!




  
    [image: 4NEC2 Installing]
    4NEC2 Installing
  




The next window to appear will be how to find the getting started and README files:




  
    [image: 4NEC2 Getting Started & README Files]
    4NEC2 Getting Started & README Files
  




Click Next to continue. The Installation Completed window will appear:




  
    [image: 4NEC2 Installation Completed!]
    4NEC2 Installation Completed!
  




Click Finish to continue. You should have the 4NEC2 Main Window, 4NEC2 Geometry Window, and the _ReadMeFirst.txt file displayed. Read through the README file, it contains the latest information about this version of 4NEC2.




  
    [image: 4NEC2 Installed]
    4NEC2 Installed
  




On the desktop, there should be three new icons.




  
    [image: 4NEC2 Desktop Icons]
    4NEC2 Desktop Icons
  




Additional 4NEC2 information is located in C:\4nec2\ directory. The _GettingStarted.txt file may be slightly out of date but feel free to use as needed. This completes the default 4NEC2 installation.








Chapter Two - Learning Your Way Around


Let’s work our way through the 4NEC2 user interface. Double-click on the 4nec2 desktop icon:




  
    [image: 4NEC2 Desktop Icon]
    4NEC2 Desktop Icon
  




to launch the program. When first started, 4NEC2 will display two windows, the Main Window, and the Geometry Window. Keep the Help File in mind as well.


Finding Help


4NEC2 comes with context sensitive Help. To access Help, at the point you  want additional information, press the [image: F1] key. From the 4NEC2 website, there’s also a forum dedicated to the software and can be found at the 4NEC2 forums.


General antenna discussions can be found on the eHAM.net antenna forum and the QRZ.com antenna forum as well.


There is a Groups.IO mailing list dedicated to this book. It’s a closed group for discussing the book, asking for clarifications, or taking the author to task for an egregious error! To subscribe, go to https://groups.io/g/4nec2defguide


The main source of announcements for this book are from Leanpub and Groups.IO.




  
    [image: Help Menu]
    Help Menu
  






  
    [image: 4NEC2 Main Help Screen]
    4NEC2 Main Help Screen
  




Main Window




  
    [image: 4NEC2 Main Window]
    4NEC2 Main Window
  




Menus


Files




  
    [image: File Menu]
    File Menu
  





  	Open 4nec2 in/out file

  	Used to open existing 4NEC2 input or output files.

  	Save Output file as

  	Save current open 4NEC2 file to another filename.

  	Import Far-Field Data

  	Far-Field Data is used by HF propagation prediction software.

  	Print

  	Print 4NEC2 project to your printer.

  	Exit | [image: ESC] | [image: CTRL] + [image: S]


  	Quit 4NEC2.




Below the Exit menu option is the most recently used file list.


Edit




  
    [image: Edit Menu]
    Edit Menu
  





  	Input (.nec) file

  	Displays the 4NEC2 Graphical User Interface (GUI) window where the antenna to be modeled is entered.

  	Output (.out) file

  	Uses the default text editor to display the 4NEC2 output file.




Settings




  
    [image: Settings Menu]
    Settings Menu
  





  	Notepad Edit | NEC editor/Geometry edit | NEC editor (new)

  	Sets the default editor for *.nec files. The default is NEC editor (new) but the Geometry Editor will be mostly used in this book. The other editors will be discussed in the full version of this book.

  	Auto segmentation

  	When checked allows long segments to automatically be broken into sub-segments. Default is 20 segments per halfwave length.





    Minimum Segments


  Minimum number of segments should be no less than 10 per half wavelength.






  	Stepped radius corr.

  	Option not available.

  	Input Power

  	Input power in Watts used to calculate voltages and currents in the near field.

  	Char-Impedance

  	Characteristic impedance of the system in Ohms. Normally 50 Ohms.

  	Pre-defined Frequencies

  	Opens the default editor where frequencies are added for frequency sweeping.

  	Pre-defined Symbols

  	Constants for Pi and wire sizes. Additional constants can be added to the Freq.txt1 file.





  	Show Circular-Polar

  	Changes the display to show circular or polar coordinate system.

  	Phi/azim unit | Length unit | Radius unit

  	Changes the units for azimuth as Phi/Theta, circular or CCW azimuth, length in meters/feet, or radius in mm/inches (AWG) of wire elements.




The next group of settings should rarely be used and will be left at their defaults for this book.



  	NEC Engine

  	Which NEC engine to use. There are several but we’ll be using the default Nec2dXS*.exe. 

  	Memory Usage

  	Optimize memory usage for number of field points, number of sweep steps, EX/LD/TL Cards2, number of SYmbols, 3D points, and patches.





  	Optimizer | ItsHF Settings | Other Settings

  	Additional analysis and 3rd party programs configuration.




Calculate




  
    [image: Calculate Menu]
    Calculate Menu
  





  	NEC output-data

  	Displays the Generate output data screen.






  
    [image: NEC Output Data]
    NEC Output Data
  




The sample version of this book will use the Far Field pattern option to generate NEC output data. Go to Edit->Output (.out) file to view the generated output file in the configured default editor.


Window


Opens different 4NEC2 program windows & viewers.




  
    [image: Window Menu]
    Window Menu
  





  	Context Sensitive Help

  	
[image: F1] -> Opens the Main Help file.


  	Main

  	
[image: F2] -> opens the Main 4NEC2 program window.


  	Geometry

  	
[image: F3] -> opens the Geometry window.





The Geometry window is detailed in the Geometry Window section.



  	Pattern

  	
[image: F4] -> opens the Pattern window





The Pattern window is detailed in the Pattern Window section.



  	Line Chart

  	
[image: F5] -> Opens the Gain/SWR/Impedance window.


  	3D Viewer

  	
[image: F9] -> Start/select 3D-viewer window.





The 3D Viewer is detailed in the 3D Viewer section.



  	Smith Chart

  	
[image: F11] -> View interactive Smith Chart





The Smith Chart is detailed in the Smith Chart section.


Show




  
    [image: Show Menu]
    Show Menu
  





  	Excite/Load info

  	Displays calculated information in Rectangular Form by replacing the Environment section of the Main Window.






  
    [image: Excite/Load info]
    Excite/Load info
  





  	Polar Notation

  	Displays the calculated results in Polar Notation. Polar Notation can be displayed by clicking on the Polar checkbox above the Excitation/Load results.






  
    [image: Polar Notation]
    Polar Notation
  




Run




  
    [image: Run Menu]
    Run Menu
  





  	Geometry Builder

  	Displays the Geometry Builder for building complex antenna and ground systems.






  
    [image: Geometry Builder]
    Geometry Builder
  




The Geometry Builder is detailed in the Geometry Builder section.



  	Picture Viewer

  	Displays plots saved in graphic format or plot files.






  
    [image: Picture Viewer]
    Picture Viewer
  





  	ItsHF

  	This menu section is covered in the ItsHF Chapter in the full version of this book.




Toolbar




  
    [image: Main Toolbar]
    Main Toolbar
  




Remainder of Main Window




  
    [image: 4NEC2 Main Window]
    4NEC2 Main Window
  





  	Filename

  	Current NEC output file

  	Voltage

  	Feedpoint voltage in complex form. Clicking on the Polar checkbox will display this calculation in polar notation.

  	Impedance

  	Series feedpoint impedance.

  	Parallel Form

  	Equivalent parallel feedpoint impedance.

  	S.W.R.50

  	The Standing Wave Ratio at 50 ohms feedpoint impedance.

  	Efficiency

  	Overall antenna efficiency.

  	Radiat-eff

  	Actual radiation efficiency. This efficiency determines how much your antenna radiates as a percentage of input power.

  	RDF [ db ]

  	Antenna gain referenced an isotropic dipole.

  	Frequency

  	The frequency the antenna was analyzed.

  	Wavelength

  	Calculated wavelength of the analyzed frequency.

  	Current

  	Feedpoint current in complex form. Clicking on the Polar checkbox will display this calculation in polar notation.

  	Series comp.

  	Series component in microhenries.

  	Parallel comp.

  	Parallel component in microhenries.

  	Input power

  	The applied power in watts from the transmitter as measured at the feedpoint of the antenna.

  	Structure loss

  	Power in microwatts (10-6) that’s lost due to the materials used in the construction of the antenna.

  	Network loss

  	Power in microwatts (10-6) that’s lost due to the matching network at the antenna feedpoint.

  	Radiat-Power

  	Amount of power in watts that’s radiated by the antenna.

  	Environment

  	Large textbox that displays the type of environment the antenna is analyzed in. This information can change depending if the Loads checkbox is checked.

  	Comment

  	Additional information contained in the comment section of the NEC input file. This information can change depending if the Loads checkbox is checked.

  	Seg’s/patches

  	The number of subsegments or patches the antenna has been divided into for analysis.

  	Pattern Lines

  	Number of lines calculated for all the segments.

  	Freq/Eval steps

  	Displays the number of frequency or evaluation steps. Analysis at a single frequency will display a 1. Analysis with frequency sweeps or multiple steps will display a number greater than 1.

  	Calculation time

  	Elapsed time 4NEC2 required to complete the antenna analysis.

  	Theta

  	Start/Stop - number of degrees in the vertical plane. (Elevation)

  	Count - total number of steps.

  	Step - how many degrees in each step.

  	Phi

  	Start/Stop - number of degrees in the horizontal plane. (Azimuth)

  	Count - total number of steps.

  	Step - how many degrees in each step.




Geometry Window




  
    [image: Geometry]
    Geometry
  




Show Menu




  
    [image: Geometry Show]
    Geometry Show
  





  	Input file | Output file

  	View antenna geometry based upon the input file data or the 4NEC2 calculated output file.

  	Wire numbers

  	Displays the number of wires in the antenna design.

  	Tag-Numbers

  	Displays the Tag number of the wire. Each wire should have different Tag numbers.





    Wire numbers and Tag numbers are displayed at the center of the wire. It’s easy to confuse these numbers. Use the Show menu to check which number is being displayed.





  	Open ends

  	Displays red-filled circles on wire ends that are not attached to anything.

  	Junctions (>2)

  	Displays the number of junctions on the antenna.

  	Segments

  	Displays each segment between a set of empty circles that are the same color as the wire.

  	Struc/Wire load

  	Displays in a brown line the load on the wire or structure - IE tubing.

  	Near/Far field

  	Displays vertical (El) & horizontal (Az) antenna pattern lines.

  	Povray -> Export Structure | Povray -> Export Far-field

  	Only used in the Standard version of 4NEC2.




View Menu




  
    [image: Geometry View]
    Geometry View
  





  	Reset

  	Returns antenna geometry to the center of the screen and default view.

  	Fix rot-center

  	Fixes the center of rotation of the antenna. Makes it easier to rotate about a fixed point.

  	Zoom in | Zoom out | Shift left | Shift right | Shift up | Shift down

  	Zoom in and out of the geometry. Shifting moves the geometry around the Geometry Window.

  	Last NEC-input

  	Displays the NEC input data in raw form using the default text editor.

  	Auto-segm. log | Step-rad. log

  	Not available.

  	SYmbol conversion

  	Opens the symbol.log file in the default text editor for custom symbols and their definitions. This is discussed in Chapter 4, NEC Editors in the full version of this book.




Validate Menu




  
    [image: Geometry Validate]
    Geometry Validate
  





  	Run geometry check

  	Manually validate the geometry of the antenna.

  	Show geo-check

  	Displays the geometry check results log file.

  	Set Auto geo-check

  	Configures 4NEC2 to automatically check antenna geometry.





    It’s best to leave this selected.





  	Run segment checks

  	Checks each segment for validity then displays the results from the Model.log file in the default text editor.

  	Show all seg-checks

  	Shows all the segment checks from the antenna geometry.

  	Segm. L(ength)

  	Validates segment length. Default in Meters.

  	Segm. R(adius)

  	Validates the segment radius. Default in Meters.

  	Segm. Len/Rad

  	Validates segment length and radius as a ratio.

  	Junc. L big/ L small

  	???

  	Junc. R big / R small

  	???

  	Junc. Len/Rad

  	???

  	Surface-patch area

  	Validates the patch area on antennas so designed.




Currents Menu




  
    [image: Geometry Currents]
    Geometry Currents
  





    Zoom in/out on the antenna before viewing the next few menu options.
If you’re interested in calculating the accurate currents and voltages for your antenna, enter the actual input power into 4NEC2 before your run the analysis.





  	Current magnitude

  	Displays the magnitude of all the currents on the antenna in green lines.






  
    [image: Current Magnitudes]
    Current Magnitudes
  





  	Phase only

  	Displays current phases.






  
    [image: Current+Phase]
    Current+Phase
  





  	Current+Phase

  	Displays both the current magnitude and phase on the antenna elements.






  
    [image: Current Magnitudes & Phases]
    Current Magnitudes & Phases
  





  	Current real

  	Displays the real component of the current on the antenna elements.

  	Current imaginary

  	Displays the imaginary component of the current on the antenna elements.

  	Magnitude as color

  	Displays a legend and current magnitude in different colors corresponding to current magnitudes.






  
    [image: Current Magnitudes]
    Current Magnitudes
  





  	Phase as color

  	Displays a color legend and phase in different colors corresponding to phase calculations.






  
    [image: Current Phase]
    Current Phase
  





  	Change orientation

  	???

  	Use traditional disp.

  	Removes the curves from the magnitude and phase displays.

  	Incr. Log-factor | Decr. log-factor

  	Increase or decrease the logarithmic calculation. Helps with very small magnitudes and phases by increasing or decreasing the height of the curves displaying current and phase magnitudes.






  
    [image: Current Magnitudes & Phases Log Factors]
    Current Magnitudes & Phases Log Factors
  





  	Next frequency | Prev frequency

  	Step through a frequency sweep to the Next or Previous frequency used in the calculations.




Far-field Menu


Displays the far field antenna pattern on the antenna geometry.



  	Next pattern | Previous pattern

  	Displays the next or previous Phi or Theta far field patterns.

  	Change grid

  	Rotates through vertical pattern, horizontal pattern, or both patterns.

  	Linear/ARRL

  	Displays the grid in linear format or ARRL format.

  	Gain as color

  	Displays total gain in V/m with corresponding magnitude legend.






  
    [image: Gain as Color]
    Gain as Color
  





  	Tilt/Phase

  	Displays phase magnitude in degree.






  
    [image: Phase as Color]
    Phase as Color
  





  	Axial Ratio

  	Displays the ratio in dB between electric fields that are ninety degrees to each other on a circularly polarized antenna.

  	Antenna Sense

  	???

  	Decrease lines | Increase lines

  	Decreases or increases the number of lines representing the far field antenna pattern.




Near-field Menu


Displays the Near field antenna pattern. This is covered in the Pattern Window section.


Wire Menu




  
    [image: Wire Menu]
    Wire Menu
  





  	Identify W/S | Identify Tag

  	Display a specific wire number, segment number, or tag number in the antenna geometry. The found wire/segment/tag will be displayed in a bright green color. A Wire/segment information box will be displayed showing relevant information on the specific segment.






  
    [image: Identify W/S/T]
    Identify W/S/T
  





  	Next | Previous

  	Steps to the Next or Previous wire/segment/tag numbers.

  	Set as center

  	Moves the found wire/segment/tag and moves it into the center of the Geometry Window.

  	Polar notation

  	Toggles between rectangular notation or polar notation in the Wire/Segment info box.




Plot Menu




  
    [image: Plot Menu]
    Plot Menu
  





  	Magnitude

  	Uses gnuplot to display magnitude plots of individual wires/segments/tags.

  	Phase

  	Uses gnuplot to display phase plots of individual wires/segments/tags.

  	Reel-part

  	Uses gnuplot to display real value plots of individual wires/segments/tags.

  	Imag-part

  	Uses gnuplot to display imaginary value plots of individual wires/segments/tags.




Pattern Window




  
    [image: Pattern Window]
    Pattern Window
  




Displays the vertical (El) and horizontal (Az) calculated patterns of the antenna under analysis.




  
    [image: Pattern Show]
    Pattern Show
  




Show Menu



  	Next pattern | Prev pattern

  	Step through each “slice” of the antenna pattern. Each “slice” is stepped through a number of calculated degrees of resolution around the pattern. Resolution is configured in the Generate Window.

  	Indicator

  	Displays an indicator in magenta on the pattern. Click the mouse on a point on the pattern to view the calculated gain and Theta/Phi. The J key isn’t needed for this feature.






  
    [image: Pattern Indicator]
    Pattern Indicator
  





  	Info

  	???

  	Structure

  	Switches to the Geometry Window.

  	Inc. struct-size | Dec. struct-size

  	Increases or decreases the size of the structure supporting the antenna.

  	Print

  	Prints out the pattern. Best results obtained from a color printer.

  	Change colors

  	Changes the colors of the Major/Minor axis and traces. This book will use the default settings.






  
    [image: Pattern Change Colors]
    Pattern Change Colors
  




Far Field Menu


The far field of an antenna is the distance from the radiating element greater than 2 wavelengths (>2[image: \lambda]). This is the field responsible for long distance communications and of primary concern to radio amateurs.




  
    [image: Pattern Far field]
    Pattern Far field
  





  	Vertical plane

  	When selected, displays the pattern’s vertical trace in blue. When deselected displays the horizontal pattern, also in blue.

  	Show both hor/ver

  	Displays both horizontal and vertical patterns. Horizontal trace is red and vertical is blue.

  	Show Multi pattern

  	Displays all patterns: Horizontal, Vertical, and Total Gain. Horizontal trace is red, vertical is blue, and Total Gain is in green. Total Gain is the combination of both Horizontal and Vertical traces. When blue and red colors are combined the resultant color is green.

  	Show Bold lines

  	Thickens all trace lines. Easier on the eyes.

  	ARRL-style scale

  	Displays traces and grid in ARRL style.

  	Font Scaling

  	Increase/Decrease the size of the fonts on the grid. Doesn’t change legend font size. 






  
    [image: Pattern Font Scaling]
    Pattern Font Scaling
  





  	Next Phi/Az slice | Prev Phi/Az slice

  	Step through vertical traces (blue) by the configured resolution. The “Show both hor/ver” must be selected.

  	Next The/El slice | Prev The/El slice

  	Step through horizontal traces (red) by the configured resolution. The “Show both hor/ver” must be selected.

  	No normalization

  	Default setting.

  	Normalize overall

  	Show the outer ring of the graph at zero (scale). All calculated values are then compared to this value.

  	Normalize each

  	???

  	High/low ranges

  	Increases/Decreases the scale of the graph.




Near Field Menu


The near field of an antenna is the distance from the radiating element out to a distance less than two wavelengths (<2[image: \lambda]). This area is critical to antenna performance and matching because if other metallic objects are within this area, they could act like unintentional antennas, causing a change in the magnetic field about the antenna. This change in magnetic field alters the overall impedance of the antenna impacting the match to the transmitter. By understanding the near field, you’ll have a much better understanding of how multi-element antennas work.




  
    [image: Pattern Near field]
    Pattern Near field
  




The near field calculations are vastly different than far field calculations. In order to calculate the near field, choose the Near Field radio button in the Generate window. Both the voltage field (E field) and magnetic field (H field) can be calculated.




  
    [image: Calculating the Near Field]
    Calculating the Near Field
  





  	Set max scale value

  	Change the maximum value for the left scale instead of using the 4NEC2 calculated maximum value.

  	Inc. log-factor | Decr. log-factor

  	Changes the scaling logarithmic factor. Displays a course to fine details of the E-field or H-field.

  	XY, XZ, or YZ plane

  	Displays the XY, XZ, or YZ planes.




XY plane fixes the Z plane and displays just the X and Y planes of the near-field.




  
    [image: XY Plane]
    XY Plane
  




XZ plane fixes the Y plane and displays just the X and Z planes of the near-field.




  
    [image: XZ Plane]
    XZ Plane
  




YZ plane fixes the Y plane and displays just the X and Z planes of the near-field.




  
    [image: YZ Plane]
    YZ Plane
  





  	Smooth line plot

  	???

  	Show MPE colors

  	Changes the display showing Maximum Permissible Exposure limits. Used for RF exposure limit calculations.

  	Next Z, Y, or X pos | Prev Z, Y, or X pos.

  	Clicking on the pattern displayed will show a cross-hair at the location of the mouse click. Using the arrow keys will move this cross-hair around the pattern.






  
    [image: Next/Prev X,Y,Z]
    Next/Prev X,Y,Z
  





  	Inc. line plot Y/Z pos. | Decr line plot Y/Z pos.

  	Increases or decreases the Y-axis and Z-axis on the line plot view of the near field pattern. Must be viewing the near field as a line plot.

  	Change to line plot

  	Changes near field pattern to display X, Y, Z values as a line plot.






  
    [image: Near Field Line Plot]
    Near Field Line Plot
  





  	Change to 2D view

  	Changes from line plot view to 2D view of the near field pattern.




Compare Menu




  
    [image: Pattern Compare]
    Pattern Compare
  





  	Add new pattern | Remove pattern

  	Allows the adding or removal of another antenna pattern from a previous calculation. This allows comparing antenna designs.




Transfer Menu




  
    [image: Pattern Import]
    Pattern Import
  





  	Import

  	Imports Full or 3D data, multiple frequency vertical plane and horizontal plane, and OpenPF data files.

  	Export

  	Exports OpenPF Full/3D and OpenPF 2D slice of an antenna pattern.






  
    [image: Pattern Export]
    Pattern Export
  




FFtab Menu



  	Elevat/Theta Slices

  	Exports individual elevation calculations for each slice of the pattern. Data is displayed in the default text editor.

  	Azimuth/Phi Slices

  	Exports individual azimuth calculations for each slice of the pattern. Data is displayed in the default text editor.




Plot Menu




  
    [image: Pattern Export]
    Pattern Export
  




The plot menu uses gnuplot to create very high quality graphs of the antenna pattern.


3D plot




  
    [image: Pattern 3D Plot]
    Pattern 3D Plot
  




2D chart




  
    [image: Pattern 2D Plot]
    Pattern 2D Plot
  




3D Viewer Window


Displays the pattern in three dimensions. Using the mouse, the pattern can be rotated through a full 360[image: ^\circ.]




  
    [image: 3D Viewer]
    3D Viewer
  




Right Toolbar



  	MHz

  	Frequency at which the calculations were performed.

  	Axis

  	The main axis of the antenna.

  	Theta & Phi

  	Displays the current values for Phi/Azimuth & Theta/Elevation as the antenna pattern is rotated.

  	Zoom

  	Zooms into the antenna pattern. Can view the far-field area around the feed point.

  	Ident

  	View a specific segment or tag within the far-field area.

  	Res

  	Resets the pattern to the center of the window.

  	Rotc

  	Selects which segment to be the center of rotation.

  	Col

  	Displays instructions on how to change the color settings. Use [image: CTRL] + [image: Q]


  	True Rad

  	Toggles between the true radius of the segments and relative radius of the elements.

  	Axis Checkbox

  	Hides the X, Y, and Z axis from the display.

  	Structure

  	Displays or hides the antenna structure under analysis.

  	Hide patt.

  	Displays or hides the antenna pattern under analysis.




Displays different far-field slices in 3D.




  
    [image: Slices]
    Slices
  





  	Tot-gain

  	Displays the Vertical/Horizontal/Total Gain pattern including E fields of Phi and Theta.






  
    [image: Gain]
    Gain
  





  	Quality

  	Changes the quality of the pattern. Author didn’t notice any perceptible changes to the pattern moving the slider back and forth.




Smith Chart


Displays impedance and S-parameters on a Smith Chart.




  
    [image: Smith Chart]
    Smith Chart
  





  	Show

  	Customize the Smith Chart; normalize the chart, change the grid density, display rectangular results, display and remove measurement points on the SWR circle, and print out the chart.






  
    [image: Smith Chart Show]
    Smith Chart Show
  





  	View

  	Increase/Decrease the frequency to be displayed on the Smith Chart and move closer/away from the generator or source.






  
    [image: Smith Chart View]
    Smith Chart View
  




Export




  
    [image: Smith Chart Export]
    Smith Chart Export
  




Export Smith Chart data in Touchstone or GAM formats.


Import




  
    [image: Smith Chart Import]
    Smith Chart Import
  




Import Smith Chart data in Touchstone or GAM formats.


Geometry Builder


The Geometry Builder is used to design complex antenna systems for analysis. Patch, Plan, Box, Cylinder, Parabola, Helix, and Spherical antennas can be designed and analyzed. See the Geometry Builder chapter in the full version of this book.




  
    [image: Geometry Builder]
    Geometry Builder
  










Chapter Three - Building and Analyzing a Dipole Antenna


We’ll start out by building and analyzing a 20M dipole antenna over real ground using the Geometry Editor. Other than a brief discussion on theoretical antennas and real antennas, this book will analyze antennas in the physical world at the author’s location.


A Word or Three about Theoretical VS Real Antennas


Isotropic Antenna


An isotropic antenna is a theoretical antenna that is located out in free space. Free space is away from earth and far away from any other physical body. It’s an antenna that doesn’t exist in reality yet it radiates equally in all directions because it’s a simple “point” in space; like the period at the end of this sentence. The sun would be a good analogy of an isotropic antenna. It’s in free space, it’s a point source, and light radiates equally in all directions as humans view it from earth. An isotropic antenna is used as a reference only antenna and has zero gain (0 dBi). It’s used as a reference of which to compare antennas and really has no other practical purpose in amateur radio.


Dipole in Free Space


A dipole antenna in free space is also a theoretical antenna but it does have some gain compared to an isotropic antenna: +2.12 dBi. This gain is measured perpendicular to the antenna around the azimuth only. 




  
    [image: Dipole Antenna in Free Space]
    Dipole Antenna in Free Space
  




The shape of the dipole is flat from end-to-end and not bent in any direction.


Real Antenna


Real antennas are what we work with here on earth. They are made from physical materials that impact radiation patterns, they interact with the ground beneath them and for several wavelengths away from the antenna. When we analyze antennas using 4NEC2, the measurements are compared to an isotropic antenna. By subtracting 2.12 dBi from an isotropic antenna measurement, the resulting measurement will be compared to a dipole in free space.


Comments on Theoretical Antennas and Such


From an engineering stand-point, theoretical antennas are the standard by which real antennas are compared to. When discussing antennas with fellow hams, gain measurements will be assumed to be either isotropic or dipole in free space. What about the measurement at your location? Would comparing your real antenna to theoretical antennas be beneficial? I would say yes and no. Yes when discussing with your ham buddies but when it comes right down to it, we’re only interested in the gain of real antennas at our physical location. If you’d like to know what the gain of your antenna is at your location, model a dipole antenna at the same height, ground type, and materials your antenna of interest will be made of. Analyze your new antenna design then compare the two. With this approach, you’ll have real world antenna measurements at your exact location. This approach might make more sense to you, but it wouldn’t make sense to other hams because they won’t understand a reference dipole at your location.


You’ll also find “claimed” antenna gain measurements in many radio related magazine ads, articles, and books. Now that you have an understanding of theoretical antennas, the units of gain in the ads/articles/books should either be dBi or dBd. If the units are simply dB, be VERY WARY of the manufacturers’ gain claims! Antenna gain is always compared to another antenna, be it isotropic or a dipole in free space.


Using the Geometry Editor


Getting Ready


Select the Geometry Editor from the Main Window as the default editor: Settings->Geometry edit. If you need to work with Imperial Units instead of Metric, it can also be changed from the Main Window: Settings->Length unit->Feet and Settings->Radius Unit->Inch/AWG


Creating a New NEC File


On the Main Window, click on the [image: Geometry Editor] toolbar button to display the Geometry Editor window. From the Geometry Editor File->New will create an empty editor. Create a new file name to save your work via File->Save. Name the file 20MDipole.nec and save it in a working directory outside of the antenna examples directories.


Design Conventions


Antennas exist in three dimensions in the real world which are easy enough to see. Drawing in three dimensions on a two dimensional display can get really confusing because you have to “imagine” the missing dimension. 


The Geometry Editor can display the antenna four different ways; in three dimensions, the YZ plane, XZ plane, and the XY plane. The last three planes help us design an antenna two dimensions at a time. In the three dimension view, the X,Y, and Z axis all meet at the origin coordinates (0,0,0).


Click on the [image: Geometry Editor] button to display the X and Y axis. By convention, the X-axis would be the “boom” of the antenna. If no boom, as we’ll see creating a dipole, it’ll be drawn over the origin (0,0), with one-half of the antenna on the positive Y axis and the other half on the negative Y axis. For example, a three element beam looks like this:




  
    [image: 3-Element Beam in XY Plane]
    3-Element Beam in XY Plane
  




The driven element (DE) is drawn on the Y-axis, with the reflector (REF) and director (D1) are drawn parallel to the Y-axis and spaced along the X-axis. Right now this antenna is laying on the ground! 4NEC2 will not like this; that’s where the Z-axis comes in.


The Z-axis is the height of the antenna above ground. Working this way allows you to concentrate on drawing the antenna in two dimensions, then by adding in the antenna height in the Z-axis, the antenna will move up in height. You won’t see this in the XY plane view because the Z-axis is coming out of the display right at you. Put your finger over the letter Z and that’s where the Z-axis is right now. 


To raise the height of the antenna, click on a wire, then in the Wire data section, add the height to the Z-axis; the Z-axis is the highlighted text boxes. 




  
    [image: Raising the Antenna]
    Raising the Antenna
  




Remember you have to add height to the Z-axis for both ends of the antenna and the values are always positive. Putting a negative value for the Z-axis will place the antenna underground! 



    How low can you go??


  4NEC2 can’t analyze antennas that are very close, on, or below ground.





Click on the [image: Geometry Editor] button, the antenna will no longer be on the ground.




  
    [image: Antenna Height]
    Antenna Height
  




Now that we’ve seen how to use the Geometry Editor, we’ll draw out the 20M dipole antenna.



    4NEC2 Doesn’t Care


  4NEC2 really doesn’t care if the antenna is drawn on the axes, or any 
specific coordinates at all. The axes are provided to make it easier
to visualize the antenna as it is being designed.





Drawing the Dipole


To calculate the halfwave length of a dipole, use the standard equation:


[image: Length = \frac{468}{f_{r}}]

[image: Length = \frac{468}{14.175}]

[image: Length = 33.01 feet]

We can call that 33 feet for this demonstration. When building this antenna, you’d want to make the overall length longer to account for the feedpoint and supporting the ends of the antenna. Plus, the ground underneath the antenna will also come into play so the length derived from the equation could be slightly shorter or longer. 


Helpful Math Trick


Here’s a simple math trick to figure out if 468 isn’t correct for your 
area. When the dipole is installed at the length of the standard equation determine the SWR at resonance. For example, resonance happens to be 
14.234 Mhz. Slightly higher than calculated. Here’s the math to figure out a new constant where:



  Original Length: 33




  New Resonant Freq: 14.234



[image: 33*14.234 \widetilde{=} 470]

Now the equation for a dipole at your location is:


[image: Length = \frac{470}{f_{r}}]

Do the calculation one more time using the new constant to determine the new length and the new dipole will be resonant at the design frequency. Anyway, back to using 4NEC2!


To draw the antenna in the Geometry Editor, click on the [image: Geometry Editor] toolbar button, on the right, use the Zoom slider to make each grid square 1 foot long, then enter the design frequency in the Frequency textbox. When you’re done, the Geometry Editor should look like this:




  
    [image: Editor Configuration]
    Editor Configuration
  




Now that the Geometry Editor is configured, click on the [image: Geometry Editor] button then draw a line as evenly as possible along the Y-axis with half the wire on the negative Y-axis, and the other half on the positive Y-axis. Click OK on the Wire Radius dialog box. 




  
    [image: Wire Radius]
    Wire Radius
  




There’s a few more configuration steps before analysis. This dipole will be made out of 14AWG wire and right now it’s 32 feet long. We need 33 feet so enter .5 in both Y-axis textboxes. The dipole is one long segment, that needs to be changed as well. Enter the following into their respective textboxes:



  	Segs: 11


  	Radius: #14


  	End-1 ft: 16.5


  	End-2 ft: -16.5






    Segments are Odd

  Remember to choose an odd number of segments. This makes it much easier to
place the source right in the middle of the dipole.




The geometry editor should look like this:




  
    [image: Antenna Details]
    Antenna Details
  




One more issue to address and that’s getting the antenna off the ground. We’ll analyze this antenna at [image:  \frac{\lambda}{2} ] above the ground which is 33 feet. Remember the Z-axis is for height above ground so enter 33 into both End-1 and End-2 text boxes.




  
    [image: Antenna Details]
    Antenna Details
  




The dipole is now 33 feet long with 11 segments and is 33 feet above ground. 



    Just One Wire?

  This dipole is a single wire in 4NEC2 and not cut in half like a 
physical antenna. 4NEC2 understands this so don’t worry about it.




Adding Ground Underneath the Dipole


4NEC2 has a wide range of ground types to choose from. Knowing which one for your area isn’t too difficult to figure out. By observation, the ground around the author’s location is slightly sandy and rocky mostly dry. Take a look around your location to see what the ground looks like. 4NEC2 has the following ground types available:



  	Free Space

  	Fast Ground

  	Perf Ground

  	Real Ground




To choose which ground to use, click on the [image: ] on the toolbar and the Ground Parameters pane will appear. Select Real Ground from the drop-down, then from the lower drop-down, select Dry, Sandy, Coastal or your own ground type if you prefer. The settings look like this:




  
    [image: Ground Type]
    Ground Type
  




Adding the Source


All that’s left is adding the source of RF to the dipole. The source will be placed right in the center of the antenna, which would be segment 6. This is the reason why it’s best to choose an odd number of segments. By placing the RF source on segment 6, that leaves 5 segments on either side of the source. Some antennas don’t have their sources in the middle and that will be discussed in the chapters on antennas.


To add a source, click on the [image: ] then [image: ] buttons. Click the [image: ] button, move the cursor on the grid and it will change to dark cross hairs. Hold down the left mouse button and drag the source to the center of the dipole coordinates (0,0). The Geometry Editor will look like this:




  
    [image: Source Added]
    Source Added
  




The source is the circle centered on the origin. Sources will always be placed in the middle of a segment.


The very light gray rectangle represents that there is a ground underneath the dipole. Click on the [image: Geometry Editor] button to see the final creation!



    Where Did the Dipole Go?

  The dipole probably went off the top of the screen. Use the Zoom slider to
zoom the grid to 50 feet. The dipole will be in view but it’ll look much
smaller. Nothing to worry about.






  
    [image: Source Added]
    Source Added
  




Analyzing the Results


Now it’s time to analyze this dipole. Click on the [image: ] button on the far right side of the Geometry Editor; the Generate window will be displayed. Select Far Field.




  
    [image: Source Added]
    Source Added
  




Click on the Generate button!


What do the results look like? The Main Window gives us the electrical details of our dipole at a half wavelength above ground. We know the feedpoint impedance, S.W.R., radiation efficiency, etc.




  
    [image: Main Window]
    Main Window
  




The part we’re interested in is the vertical gain, where is the signal going when it leaves the antenna and heads towards the horizon. At [image:  \frac{\lambda}{2} ] above ground, it looks like this:




  
    [image: Vertical Gain 1/2 Wave Above Ground]
    Vertical Gain 1/2 Wave Above Ground
  




The main lobe is [image:  30^\circ ] above the horizon over real, dry, sandy, coastal soil. What would the vertical gain look like at different heights? Change the Z-axis to 16 feet or about [image:  \frac{\lambda}{4} ] above the ground. After calculation:




  
    [image: Vertical Gain 1/4 Wave Above Ground]
    Vertical Gain 1/4 Wave Above Ground
  




That’s called a “cloud warmer” - the major lobe is at [image:  70^\circ ] above the horizon. Great for local communications but not so much for chasing DX. In any case though, it’s better than no antenna at all!


Change the Z-axis to 48 feet or [image:  \frac{3}{4}\lambda ] wavelength above ground. What does that look like?




  
    [image: Vertical Gain 3/4 Wave Above Ground]
    Vertical Gain 3/4 Wave Above Ground
  




Now the pattern really changes! Our major lobes are now [image:  20^\circ ] above the horizon. What has caused the signal to have a lobe going straight up? The ground beneath the dipole is acting like a reflector. The dipole is still emanating a signal a full [image:  360^\circ ] but the distance to the ground is such that the signal that’s reflected back up adds to the signal that’s already going straight up. Gives it a clown hat like shape.


What does [image:  1\lambda ] look like? Enter 66 in the Z-axis and generate another set of results. It looks like this:




  
    [image: Vertical Gain 1 Wavelength Above Ground]
    Vertical Gain 1 Wavelength Above Ground
  




The major lobe is now [image:  15^\circ ] above the horizon, but the lobe pointing straight up has been squished down some and widened.


What does [image:  2\lambda ] above ground look like? Enter 123 for the Z-axis and generate another set of results. It looks like this:




  
    [image: Vertical Gain 2 Wavelengths Above Ground]
    Vertical Gain 2 Wavelengths Above Ground
  




The major lobe is now [image:  10^\circ. ] above the horizon, but more lobes have appeared and the straight up portion is narrower than before.


Conclusion


Modeling antennas isn’t all that difficult. This example we used a 20M antenna modeled at various heights above real ground. The pattern that shows  for every [image:  \frac{\lambda}{4} ] the antenna is above ground, the major lobe angle drops by about [image:  20^\circ ]. It’s not until we reach [image:  1\lambda ], where the major lobe is at its lowest - the best for DX communications. Going another wavelength higher, the major lobe angle starts to increase again, so going higher isn’t always better.





** The following chapters are in the full version of 4NEC2 The Definitive Guide **







Chapter Four - 4NEC2 Editors


4NEC2 Geometry Editor


NEC Editor (New)


NEC Editor


Notepad Editor







Chapter Five - Geometry Builder







Chapter Six - Optimizer







Chapter Seven - L/Pi/T Matching







Chapter Eight - Graphing with gnuplot







Chapter Nine - Using ItsHF & VOACAP


Models


Area Coverage


Point-to-Point







Chapter Ten - Verticals


Very Short Verticals


Quarter Wave


40M and why it works on 15M.


Half Wave


5/8 Wave


Mobile Antennas







Chapter Eleven - Multi-Element


Beams


Log Periodics


Quads







Chapter Twelve - Loops


Single Band Loop


Multiband Loop


Magnetic Loop







Chapter Thirteen - VHF/UHF/SHF Antennas


Patch


Discones


Helix


Parabolic


2.4 GHz Pringles WiFi Antenna


2.4 GHz High Gain Loop WiFi Antenna







Chapter Fourteen - Antenna Menagerie!


In no particular order, it’s a menagerie after all!


Rhombics


Pennents


80M Parabolic


A tribute antenna to KV7J(SK) and WD8OSU.







Appendix B - NEC User Manual Installation







Appendix C - Gnuplot Installation & Configuration







Appendix D - ItsHF & VOACAP Installation & Configuration








4NEC2 Function Keys & Keyboard Shortcuts Cheat Sheet


Main Window


Function Keys


[image: F1] -> Opens the Main Help file.


[image: F2] -> Opens the Main 4NEC2 program window.


[image: F3] -> Opens the Geometry window.


[image: F4] -> Opens the Pattern window


[image: F5] -> Opens the Gain/SWR/Impedance window          


[image: F6] -> View or Edit 4NEC2 data window      


[image: F7] -> Generate/analyze antenna system


[image: F8] -> View NEC output-file using default editor


[image: F9] -> Start/select 3D-viewer window


[image: F10] -> Calculate L/Pi/T Matching


[image: F11] -> View interactive Smith Chart


[image: F12] -> Opens Optimizer/Frequency Sweep window


Keyboard Shortcuts


[image: W] -> Exciter/Load Info Window


[image: X] -> Polar notation


[image: CTRL] + [image: O] -> Open 4NEC2 file.


[image: CTRL] + [image: P] -> Print current window.


[image: CTRL] + [image: S] -> Save 4NEC2 output file.


[image: CTRL] + [image: Z] or  [image: ESC] -> Quit 4NEC2.


[image: CTRL] + [image: F1] -> Use Notepad Edit


[image: CTRL] + [image: F2] -> Use NEC editor


[image: CTRL] + [image: F3] -> Use Geometry Edit(or)


[image: CTRL] + [image: F4] -> Use NEC editor (new)


Geometry Window


Function Keys


[image: SHIFT] + [image: F4] -> Export Structure


Keyboard Shortcuts


[image: A] -> Auto-segm. log


[image: B] -> Current + Phase


[image: C] -> Current magnitude


[image: D] -> Last NEC-input


[image: E] -> Open ends


[image: F] -> Fix rot-center


[image: G] -> Change orientation


[image: I] -> Input file


[image: J] -> Junctions (>2)


[image: K] -> Step-rad. log


[image: N] -> Wire Numbers


[image: O] -> Output file


[image: P] -> Phase only


[image: Q] -> Run geometry check


[image: R] -> Near/Far field


[image: S] -> Segments


[image: T] -> Tag Numbers


[image: U] -> Use traditional disp.


[image: W] -> Struc/Wire load


[image: X] -> Polar notation


[image: Y] -> Current real


[image: Y] -> Show geo-check


[image: Z] -> Current imaginary


[image: 1] -> Segm. L(ength)


[image: 2] -> Segm. R(adius)


[image: 3] -> Segm. Len / Rad


[image: 4] -> Junc. L big/L small


[image: 5] -> Junc. R big/R small


[image: 6] -> Len / Rad


[image: 7] -> Surface-patch Area


[image: 9] -> Run segment checks


[image: 0] -> Show all seg-checks


[image: HOME] -> Reset


[image: PU] -> Zoom In


[image: PD] -> Zoom Out


[image: RIGHT] -> Next frequency


[image: LEFT] -> Prev frequency


[image: ?] -> Identify W/S (Wire/Segment)


[image: ALT] + [image: UP] -> Incr. Log-factor


[image: ALT] + [image: UP] -> Decr. Log-factor


[image: ALT] + [image: RIGHT] -> Next


[image: ALT] + [image: LEFT] -> Previous


[image: ALT] + [image: HOME] -> Set as Center


[image: CTRL] + [image: P] -> Print


[image: CTRL] + [image: Q] -> Changes colors


[image: CTRL] + [image: Left] -> Shift Left


[image: CTRL] + [image: Left] -> Shift Right


[image: CTRL] + [image: Left] -> Shift Up


[image: CTRL] + [image: Left] -> Shift Right


[image: CTRL] + [image: Left] -> Shift Down


[image: SHIFT] + [image: P] -> Phase as color


[image: SHIFT] + [image: R] -> Export Far-Field


[image: SHIFT] + [image: Y] -> SYmbol conversion


[image: SHIFT] + [image: ?] -> Identify Tag


Pattern Window


Keyboard Shortcuts


[image: B] -> Show Bold lines


[image: D] -> Show both hor/ver


[image: G] -> Structure


[image: H] -> Show MPE colors


[image: I] -> Info


[image: J] -> Indicator


[image: L] -> ARRL-style scale


[image: M] -> Show Multi pattern


[image: O] -> Smooth line plot


[image: >] -> Next pattern


[image: <] -> Previous pattern


[image: PU] -> Inc. struct-size


[image: PD] -> Dec. struct-size


[image: RT] -> Next Phi/Az slice


[image: LT] -> Prev Phi/Az slice


[image: RT] -> Next The/El slice


[image: RT] -> Prev The/El slice


[image: HOME] -> Select No Normalization


[image: DEL] -> Set max scale value


[image: RT] -> Next Z, Y or X pos.


[image: LT] -> Prev Z, Y or X pos.


[image: UP] -> Inc line plot Y/Z Pos.


[image: DN] -> Dec line plot Y/Z Pos.


[image: PUP] -> Change to line plot


[image: PDN] -> Change to 2D view


[image: INS] -> Add new pattern


[image: DEL] -> Remove pattern


[image: ALT] + [image: HOME] -> Incr. log-factor


[image: ALT] + [image: HOME] -> Decr. log-factor


[image: CTRL] + [image: P] -> Print


[image: CTRL] + [image: Q] -> Change colors


[image: SPACE] -> Show Vertical Plane


[image: SPACE] -> Each tap will display XY, XZ, or YZ Plane


Smith Chart


Keyboard Shortcuts


[image: G] -> Course grid


[image: S] -> SWR Circle


[image: X] -> Polar Notation


[image: HOME] -> Normalized


[image: INS] -> Insert Z/Y


[image: DEL] -> Delete Z/Y


[image: RT] -> Next frequency


[image: LT] -> Prev frequency


[image: CTRL] + [image: P] -> Print


[image: SHIFT] + [image: LT] -> Move to gen.


[image: SHIFT] + [image: LT] -> Move to load










Change Log



  v2.0 08/14/2021 :: KA6WKE :: General updates to manuscript, tpyo hunting & fixin', move to github for publishing




  v1.1 08/22/2015 :: K9SRV  :: Fixed typo in equation for dipole in graphics and text.




  v1.0 07/25/2015 :: KA6WKE :: Initial sample release.









Appendix A - Directories & File Locations


Default 4NEC2 installation directories and file locations. Not all files are listed, only the ones the end-user can modify including examples, output & plot files.



 1 C:\4nec2>
 2 │   Cards.rtf <- NEC2 reference card.
 3 │   Nec2.doc  <- NEC-2 Manual, Part III: User’s Guide.
 4 │
 5 ├───data <- Support files to add custom parameters and specifications.
 6 │       Coax.txt     <- Coax cable parameters.
 7 │       Conduc.txt   <- Wire conductivity constants.
 8 │       default.pov  <- Customize the scene in which the NEC2 structure or far-field pattern i\
 9 s placed.
10 │       Dielec.txt   <- Add custom dielectric constants for different materials.
11 │       Edit2.txt    <- Deprecated
12 │       Edit4.txt    <- Deprecated
13 │       Freqs.txt    <- Frequency-list (in mhz) for freq-sweep 'from file'.
14 │       Ground.txt   <- Conductivity and dielectric constant for different ground types.
15 │       Sunspot.txt  <- Sunspot numbers through 2020.
16 │       Symbols.txt  <- Default SY(mbols)/constants to be used in 4NEC2; Pi, wire radius, etc.
17 │       ToolTip2.txt <- NEC2 help text for Nec edit (new) DO NOT CHANGE!
18 │       ToolTip4.txt <- NEC4 help text for Nec edit (new) TBD - DO NOT CHANGE!
19 │       _ReadMe.txt
20 │
21 ├───exe    <- Main binaries and other files used by 4NEC2.
22 │
23 ├───its    <- ITS HF recieve and transmit coverage sample files. See: http://www.greg-hand.com\
24 /hfwin32.html
25 │
26 ├───models <- Plenty of examples of HF/VHF/UHF antennas.
27 │
28 ├───out    <- Input file for NEC2 and output files generated after NEC2 executes.
29 │
30 ├───plot   <- Dirctory used to store various plot files when exporting to GAM formatted file &\
31  used by gnuplot.
32 │
33 └───pov    <- Persistence of Vision Raytracer. See: https://www.povray.org/










Notes


        
      

1See Directory and File Locations Appendix.↩


      

2Cards are documented in the Editors Chapter in the full version of this book.↩
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[version 5.6.8] Short (ahum) explanation how to create/install the 4nec2 enviromment
(Windows-25/28/ME/NT/2000/XB/WT)

IMPORTANT: Starting with version 5.8.3. the nome 3D style 4nec2.gye program has
become obsolete. Tne full featured 4nec2X.gxe program is renamed to
4nec2.exs (without the 'X') and is now the default program to use.

--> In case of problems be sure you red the sections next to the below

installation steps.

kX

5

install the 4nec2 package, follow the below steps.

1) Extract the setup énec2.gxs program from the 4nec2.zip file and copy or move
it into a temporary folder.

2) Double click the setup_4nec2.gxs program. This wil automatically install énec2.gxe
and other required files used by the 4nec2 package.

3) Starc the 4nec? program. If 4nec2 was not installed in the default folder, the
‘Open file' box could show up. Then browsy o vou ..\4nec2\models folder and select
one of the example files to open and load ingip énec2.

4) When using 4nec2 together with a licensed Neg-4 engine instead of the default
public-domain Neg-2 engines, read below item d) first.

S) Te use GnuPlot for additional plotting, download GnuPlot version 4.0 from the
4nec2 website and unpack the gp400win32.zip file into one or the other folder on

fength: 15693 fines: 261 i1 Col:1 Sel:0[0 DostWindows

UTF-8 w/o BOM

4172015
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Prt__Optons

NEC visualization, optimization and sweeping tool

‘The dnec2 tool is a windows- and Nec-2 or Nec-4 based tool for both the starting and experienced antenna modeler that can be used to create,
view and check your antenna geometry structure and generate, display and compare near- and farfield radiation patters. Also SWR, input
impedance, F/B- and/or F/R-ratio for a range of frequency’s on a linear or logarithmic graph (or Smith-Chart) can be displayed.

Furthermore an optimizer and sweeper is included. With this optimizer you are able to optimize antenna- and/or other environment-variables for
Gain, resonance, SWR, effciency and/or Front to Back ratio. With the sweeper you are able to graphically display the effect of changing one or
more antenna- and/or environment-variables for a specified range of values/frequencies

For the starting antenna-modeler a graphically based 3D geometry-editor is included which required no additional NEC knowledge while still
enabling you to create and visualize current-distribution, far/near-fieid patterns and Gain/SWR charts

To be able to use one of both optimizers or the sweeper, some basic knowledge about the NEC syntax is required. So one is able to (textually)
create NEC based geometry structures and know something about the results when using GN, EX, LD, and FR cards

Although this help-file might look comprehensive, this is not directly related to the complexity of the nec2 package but much more to the large
‘amount of features available. Considerable effort was taken to get used to 4nec2 without the need to first read the complete help-fle.

The dnec2 tool consists of four general forms/windows: Main, Geometry, Pattem, Line-chart plus an Edit-, Matching-, Smith-chart and an
Optimizer/Sweeper form. Each form contains a menu bar with menu-options. Most of these menu-options speak for themselves. Try out each of
these menu-options and see what the results are. However there are some options who are more difficult to understand. These options are

discussed in more detail further on in this help file. To get specific (context sensitive) help for a certain window/form just push the F1 when the
formwindow is on-top.

When the dnec2X eXtended version is installed the real-time 3D-viewer is also available for use. However this version requires a more modem
‘computer-system and graphics-card.

In all the forms you can process the general buttons F1 to F12, Ctik#0 and Ctri+Z / Esc. These buttons, for which also a menu-option is
included in the Main' form, have the following meaning

F1 Display this help file

F2 Select Main form

F3 Select Geometry form

F4 Select Pattem form

F5  Select Line-chart form
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F6 View or Edit (4nec2 input data
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